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Introduction

Objective

The objective of this Calibration Guide is to establish a procedure that you can follow to determine the
Strain Scaling Factor (SSF) and Anisotropic Strain Coefficients (ASCs) for use in the ANSYS Additive Print
software. The calibrated SSFs and ASCs will significantly improve the prediction accuracy of the simulation
software, therefore improving the chance of successful builds as well as reducing the cost of trial and
error experiments.

Figure 1: SSF required for Assumed Strain simulations in Additive Print
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Introduction

Figure 2: SSF and ASCs required for Scan Pattern and/or Thermal Strain simulations in Additive
Print
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Procedure

The calibration procedure consists of building parts, taking measurements, running simulations, and
calculating factors using a spreadsheet. You will start by building three identical parts using a different
scan pattern for each. You'll determine an initial set of SSF and ASC values using the first two scan
patterns, and then fine-tune the values with the third scan pattern. Our experience shows that the third
scan pattern calibration step increases the accuracy of simulations for user-preferred scan patterns. We
strongly recommend the fine-tuning step that uses the third scan pattern.

Here is the overall procedure:
1. Build all calibration parts on the same build plate

For convenience, we recommend building all the parts on the same build plate. Use the same
part for all calibration steps but use a different scan pattern for each. The dimensions of the
part may be adjusted depending on the material, machine, and process parameters to achieve
a successful build. The procedure remains the same regardless of part dimensions. More details
are available in Building the Parts (p. 7).

2. Measure the dimensions of the built parts to determine distortion

Using the best measurement method available, measure the dimensions of the parts at the
recommended locations of interest. Record the dimension measurements in the ANSYS-provided
spreadsheet and distortions at those locations will automatically be calculated. More details

are available in Taking Distortion Measurements (p. 11).

3. Run calibration to determine an initial set of factors (for each simulation type and stress mode
combination)

For a chosen combination of simulation type and stress mode, run simulations of the calibration
part in Additive Print (and ANSYS Workbench if choosing in support-only cutoff under J2 plas-
ticity mode). Use the spreadsheet provided to calculate factors based on a distortion average

Release 2020 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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from the first two scan patterns. More details are available in Running the Simulations (p. 15)
and Using the Spreadsheet to Calculate SSF and ASCs (p. 27).

Run fine-tuning calibration step with a different scan pattern

For the same combination of simulation type and stress mode, run simulations with the newly
calibrated factors and use the spreadsheet to fine-tune the factors based on distortion from
the third scan pattern.

When to Calibrate

The values for SSF and ASCs depend upon the following:

Material
Machine

Machine parameters (laser power, scan speed, layer thickness, baseplate temperature, hatch spacing,
slicing stripe width, scan pattern, etc.)

Simulation type performed (Assumed Strain, Scan Pattern, or Thermal Strain)

Stress mode selected (linear elastic or J2 plasticity)

Assuming you perform the full procedure, for each calibration you will have a complete set of values

to be used for any simulation type/stress mode for a given material and machine. When a different ma-
terial or machine is chosen, the ASC and SSF values will need to be recalibrated, regardless of the sim-
ulation type or stress mode. Even changing the material supplier for a material you have already calibrated
for may require a new calibration. If the process parameters are altered, Assumed Strain and Scan Pattern-
based simulations will need to be recalibrated.

Important:

You need to calibrate only for the type of simulation you will be performing. For example,

if you know you will be performing Assumed Strain simulations only, you don’t need to build
multiple calibration parts because scan pattern doesn't matter and you don't need to complete
the calculations for ASCs, as those factors are required only for Scan Pattern and Thermal

Strain simulation types. Within your Assumed Strain simulations, if you know you will be

using linear elastic stress mode only, there is no need to calibrate for J2 plasticity. See the
ANSYS Additive User’s Guide for further information about simulation types and stress modes.

Matrix of SSF and ASCs

Table 1 shows a complete matrix across different simulation types and stress modes for a certain mater-
ial, A. After the full calibration process, you will record final values in the color-filled fields that are
unique to that material and machine.

Table 1: Complete matrix of SSF and ASCs

Material Stress Mode Assumed Strain Scan Pattern Thermal Strain
i SSF SSF
A Linear SSF
Elastic ASC ASC
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Material

Stress Mode

Assumed Strain

Scan Pattern

Thermal Strain

A
ASC L ic
ASC_z 1 ASC_z 1
SSF SSF
ASC ASC
J2 Plasticit SSF A
Y ASC L ic
ASC _z 1 ASC z 1
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Cantilever Beam Geometry

Geometry files of a cantilever beam part and its support, in .stl format, are available for download.

The part dimensions (50 x 10 x 12.5 mm) are shown in Figure 3 (p. 5). The part and its support are
shown together in Figure 4 (p. 5). The red dashed line represents the support cutoff location.

Figure 3: Cantilever beam dimensions

Figure 4: Cantilever beam with support

- |ocation of support cutoff

-l
ML )
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Building the Parts

Part Layout

We recommend you build the calibration parts on the same build. There will be three cantilever beam
parts, each with a different scan pattern. The three calibration parts differ only in scan pattern. (If you
will be doing Assumed Strain simulations only, then only one part is needed and use the rotating stripe
scan pattern.)

Implement an appropriate layout consistent with the best practice for taking gas flow direction into
account. Ensure there is enough space between the parts to take measurements before the parts are
cut from the baseplate. The parts need to be measured while they are fixed to the plate; hence, it is
important to keep enough space between neighboring parts.

Support Structure

The support structure of the cantilever beam is provided; the parts should be built on the baseplate
directly.

Process Parameters

With the exception of the scan patterns that are described below, the parts should be built with the
process parameters (laser power, scan speed, etc.) that you are intending to use for building your real
components. Make sure to use the same build parameters and scan patterns for both the part and the
supports.

Scan Patterns

Build the calibration parts with the scan patterns as shown in the following figures. (For Assumed Strain
simulations, only scan pattern 3 is needed.)

+ Scan pattern 1: bi-directional scan with 0° starting angle and 0° layer rotation angle, scan line is either
0° or 180°. See Figure 5 (p. 8).

+ Scan pattern 2: bi-directional scan with 90° starting angle and 0° layer rotation angle, scan line is either
90° or 270°. See Figure 6 (p. 8)

+ Scan pattern 3:use the scan pattern that you are intending to use for building real components. In this
guide we use a rotating stripe scan pattern with a 0° starting angle and a 67° rotation angle. See Figure
7 (p.9)

+ There should be no extra scans such as contour scan, up-skin and down-skin, shrinkage factor, etc.

Release 2020 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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Building the Parts

Figure 5: Scan pattern 1 (0°, 0°)

Scan Pattern 1 (0,0)
- Black arrows denote laser scan vectors
- Gold arrow denotes stripe scan direction

Figure 6: Scan pattern 2 (90°, 0°)

Scan Pattern 2 (90,0)

- Black arrows denote laser scan vectors
- Gold arrow denotes stripe scan direction
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Figure 7: Scan pattern 3 (rotating stripe)

Scan Pattern 3 (rotating stripe)
- Black arrows denote laser scan vectors
- Gold arrow denotes stripe scan direction

Important:

Pay attention to the legend in Figure 5 (p. 8) and Figure 6 (p. 8). The angles refer to the
direction of the laser, not the stripe direction. The X-axis in this guide always runs parallel

to the length of the cantilever. Should your machine use a different coordinate system, make
sure that scan pattern 1 (0°, 0°) results in the laser scanning parallel to the length of the
cantilever. In order to achieve this, it may be necessary to set the stripe width to the length
of the cantilever (50 mm) or more.

For scan pattern 2 (90°, 0°), the stripe width may need to be set to the width of the cantilever
(10 mm) or more.

Release 2020 RT- © ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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Taking Distortion Measurements

Measurement Locations
Measurement locations are shown in the following figures.

« Measurement A is along the center line of the cantilevered edge face (Y=5, X=0 mm) before cutting off
the support, as shown in Figure 8 (p. 11).This is the default measurement location.

+ Measurement B is along the center line on the top surface of the cantilever beam (Y=5 mm, Z=12.5
mm) after cutting off the support, as shown in Figure 9 (p. 12).This is an optional measurement location.

Figure 8: Measurement location A

Measurement A
- Along center line of cantilevered edge face (Y=5 mm)
- Before support cutoff
- X component of displacement is of intarest
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Taking Distortion Measurements

Figure 9: Measurement location B

Measurement B

- Aleng center line of top face (Y=5 mm)
- After support cutoff
- Z component of distortion Is of Interest

Our experience has shown that measurement A may be a little difficult to measure. This is why we
provide an alternative measurement location, B. Measurement A is usually more sensitive to SSF, however.

If you use a different geometry instead of the cantilever beam, choose one measurable location of interest
based on the geometry to perform the calibration.

Measurement Methods

Several measurement methods are available and described below. Choose a measurement technique
with the best resolution available.

CMM

If using a Coordinate Measurement Method (CMM), measure many points in a line along the chosen
surface of the cantilever beam. Find the maximum deflection for the measurement location(s).

+ The maximum X-deflection for measurement A (see Figure 8 (p. 11)) will generally occur at the interface
between the beam and the supports, but we recommend comparing measurements along the height.

+ The maximum Z-deflection for measurement B (see Figure 9 (p. 12)) will generally occur at the canti-
levered end of the beam, but we recommend comparing measurements across the top surface.

Record the value of the dimensions on the spreadsheet provided by ANSYS.
Laser Scanner

If using a laser scanner, point cloud or scanned STL file can be obtained. Measure distortion at the X
and Z locations of interest.

Caliper/Micrometer and a Digital Height Gage

If using a caliper/micrometer, we recommend using calipers with fine detail extensions and a digital
height gage to mark the height. Measure the dimension of the cantilever beam at the location of interest.
This measurement technique is less accurate than the other methods and may result inaccurate distortion,
SSF, and ASC values. Therefore, this is the least preferred measurement method.

Release 2020 RT- © ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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As a last resort, if you do not have a digital height gage, you may want to consider modifying the .stl
file to include detents at the location of interest and then use this modified geometry in your simulations.
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Running the Simulations

In Additive Print, keep the following settings consistent for all simulations:
+ Cantilever beam part (Cantilever_ANSYS_part.stl)
+ Cantilever beam support (Cantilever_ANSYS_support.stl)

+ Voxel size: 0.25 mm (This is a suggested value, it can be modified but should be kept consistent
throughout all simulations. We recommend you use the voxel size that you will be using for your own
part.)

+ Material properties, either from an ANSYS-predefined material or your customized material
+ Process parameters (needed for Scan Pattern and Thermal Strain simulations)

Use the default output options for measurement A. For measurement B, choose "Displacement after
cutoff" and specify the "Support-only Cutoff" option from the drop-down.

Note:

When obtaining the support-only cutoff value for measurement B in J2 plasticity mode,
ANSYS Workbench/Mechanical will also need to be employed to capture the distortion
and account for its value from the support cutoff process. ANSYS Workbench/Mechanical
is not required for simulations using linear elastic mode or on-plate distortion simulations
using J2 plasticity mode.

Additive Print allows you to prepare multiple simulations and queue them up to automatically run one
after another.

Simulations with the First Two Scan Patterns
Scan Pattern/Thermal Strain:

+ Start with the default SSFy= 1
+ Start with default ASC, (1.5,0.5, 1)

+ Scan pattern 1 - use 0° starting angle and 0° layer rotation angle

*+ Scan pattern 2 - use 90° starting angle and 0° layer rotation angle

Simulations with the Third Scan Pattern (Fine-tuning Step)
Assumed Strain:

+ For both linear elastic and J2 plasticity, start with the SSF,=1

Release 2020 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
of ANSYS, Inc.and its subsidiaries and affiliates. 15


http://storage.ansys.com/doclinks/ansys.html?code=AddCalibration-ALU-M1a
http://storage.ansys.com/doclinks/ansys.html?code=AddCalibration-ALU-M1a

Running the Simulations

Scan Pattern/Thermal Strain:
+ For both linear elastic and J2 plasticity, start with the calibrated SSF
+ Use the calibrated ASCs

+ Machine Configuration - Use the scan pattern angles you used to build the third part (such as scan
pattern 3 as shown in Figure 7 (p. 9)).

Extracting Distortion Data

Figure 10: Workflow diagram for obtaining distortion simulation values, measurements A and B (p. 16)
shows a diagram of the procedure for obtaining distortion data, measurement A and measurement B.
These measurements are required input values used in the ANSYS Additive Calibration spreadsheet to
calculate the Strain Scaling Factor (SSF) and the Anisotropic Strain Coefficients (ASCs). See Figure 9: Meas-
urement location B (p. 12) for detailed instructions on using the Calibration spreadsheet.

Figure 10: Workflow diagram for obtaining distortion simulation values, measurements A
and B

On-plate residual J n
‘ stress/distortion | measurement

Linear Elastic Support-only cutoff |

— measurement B

Additive Print ol U .
Simulations :
- Tall |
ol ElEL stress/distortion ] |
ok — measurement B
Workbench/Mechanical Support-only cutoff | §
Simulations displacement

Calibration data
for spreadsheet

________________

I
|
I
On-plate residual |—* measurementA |
I
|
I

Measurement A

For simulation of measurement A, use the On-plate residual stress/distortion results to extract the
directional component of displacement at the ends of the cantilever beam at the location of interest,
Measurement A. Use either the ANSYS viewer in Additive Print to view the results (hover the mouse
over the location of interest to get the displacement) or export the files to view in another viewer ap-
plication.
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Measurement B

Linear Elastic Mode

For simulation of measurement B in linear elastic mode, use the Displacement after cutoff > Support-
only Cutoff results to extract the displacement in the Z direction along measurement B.

Note:

Locations of data extraction from the simulations should match the measurement locations.

Figure 11: Selected points on support (left) and on cantilever beam part (right) along measurement
A

Figure 12: Selected points on cantilever beam along measurement B after cutoff

The data point coordinates at the locations of interest, as shown in Figures 8 (p. 11) and 9 (p. 12), are:
+ Measurement A: (0, 5,8.5) to (0,5 ,12.5) Use X-displacement value

+ Measurement B: (0, 5, 12.5) to (50, 5, 12.5) Use Z-displacement value

The distortion on measurement A is the maximum X-displacement value.

The distortion on measurement B is the maximum Z-displacement value at X = 50 mm.
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Running the Simulations

Paraview is an open-source, multi-platform data analysis and visualization application. Within Paraview,
extract the distortion data by doing the following:

Open the appropriate files and make it active.
Edit > Find Data...

Figure 13: Example of how to use Paraview to find displacement value for measurement B

M Find Data 7 4
TEIIES 1. Select data source
Find [ = Powtia) <) trom|[smanses-shes cutol-Bepiscemert ot S ol file

e —— o |5 ]

X = Jraarest 1o ﬂll
L __...-FE bt withins apeion E]

| Fun Selection Query

2. Enter point
coordinates

Current Selection |sim3E0es- after cutoff - displecement. vtk : 0)

Shove: "o Poinas) |1 et 3. Run Selection
Point 1D | Points | disp_{mm) | Query

ﬂﬁ?‘?ﬂ] 0,5, 125 0534203, QO535459 345604
4. Record

displacement value

Solection Bieplyy Propsrtios
i selecton Cokir @ Cell Lobels v] © Font Labsls 'J_[J
Frears Sslecuon | Estract Selechon | Flot Selectices Over Time. | Clase

Figure 14: Point highlighted after using the "Find Data" query
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J2 plasticity mode

For simulation of measurement B in J2 plasticity mode, there are two components: On-plate
stress/displacement and Support-only cutoff stress/displacement. On-plate stress/displacement

is obtained from Additive Print at the location defined in Figure 12: Selected points on cantilever beam
along measurement B after cutoff (p. 17) followed by the procedure described above using Paraview.
Support-only cutoff stress/displacement is obtained from ANSYS workbench at the same location
(delineated in Figure 12: Selected points on cantilever beam along measurement B after cutoff (p. 17)).
The sum of these two simulation stress/displacement values are the final values that will be used in the
calibration spreadsheet.

When setting up the Additive Print for J2 palsticity mode Support-only cutoff simulation, make sure

to check the Files for transfer to ANSYS Mechanical option in the Outputs section. Once the simulation
is completed, export and unzip this file. Four different files are saved within the folder, as shown in
Figure 15: Files for transfer to ANSYS Mechanical (p. 19). You do not need to check the Displacement
after cutoff option since this data will not be used for calibration for this particular scenario.

Figure 15: Files for transfer to ANSYS Mechanical
sim233-mapdl * =im233-mapd|
Marme

B displacements
knockdowns.ist

model.cdb

states.ist

The contents of these files are as follows:

di spl acenment s. csv contains cantilever displacement values generated in Additive Print.
knockdowns. i st contains knockdown factors for the entire part.

nodel . cdb contains material properties, part/support geometry information, and boundary
conditions.

st at es. i st contains strain information generated in Additive Print.

The procedure for using ANSYS Workbench/Mechanical to obtain the Support-only cutoff displacement
value needed to calculate measurement B (see Figure 10: Workflow diagram for obtaining distortion
simulation values, measurements A and B (p. 16)) is divided into 25 steps described in detail here. Open
ANSYS Workbench, and perform the first three steps, illustrated in Figure 16: ANSYS Workbench/Mech-
anical setup steps 1-3 (p. 20). Drag an External Model module from Component Systems and a Static
Structural module from Analysis Systems to the Project Schematic layout (steps 1 and 2). Link Setup in
External Model to Engineering Data and Model in Static Structural, respectively (step 3).
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Running the Simulations

Figure 16: ANSYS Workbench/Mechanical setup steps 1-3
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Right click Setup and choose Edit... in the External Model module to open a new tab, A: External
Model. (step 4 in Figure 17: ANSYS Workbench/Mechanical setup steps 4-6 (p. 20)). In the A: External
Model tab, click ... under location (step 5) to select import the nodel . cdb file saved in the files for
transfer to ANSYS mechanical folder (step 6).

Figure 17: ANSYS Workbench/Mechanical setup steps 4-6
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The next steps are shown in Figure 18: ANSYS Workbench/Mechanical setup steps 7-10 (p. 21). Click

the Project tab to return to the Project Schematic page (step 7), right click the Setup cell in the External
Model module (step 8), choose Update from the drop-down menu, and wait until the question mark
on Setup becomes a green check mark (step 9). Repeat this updating procedure (right click and select
Update) for the Engineering Data and Model cells in the Static Structural module, respectively (step
10). Green check marks will be displayed beside each cell, indicating that they have properly updated.
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Figure 18: ANSYS Workbench/Mechanical setup steps 7-10
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Double-click the Model cell in Static Structural to run ANSYS Mechanical. The ANSYS Mechanical applic-
ation window is shown in Figure 19: ANSYS Workbench/Mechanical setup steps 11-12(p. 21). Click the
Geometry object in the tree in the Outline pane to access the Details of "Geometry" pane (step 11).
Change the Element Control in the Details view from Program Controlled to Manual (Step 12).

Figure 19: ANSYS Workbench/Mechanical setup steps 11-12
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Figure 20: ANSYS Workbench/Mechanical setup steps 13-14 (p. 22) illustrates the next steps. To activate
the command window where you will set up the support-only cutoff process using MAPDL commands,
right click Static Structural in the OQutline pane (step 13), and choose Insert > Commands (step 14).
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Running the Simulations

Figure 20: ANSYS Workbench/Mechanical setup steps 13-14
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In the command window, type in the following commands; see also Figure 21: ANSYS Workbench/Mech-

anical setup step 15 (p. 23).

I NI STATE, r ead, st ates, i st, C./Users/ ANSYS/ Deskt op/ Test/ si m233- mapdl / si m233- mapd

I NI STATE, list, 1

I NI STATE, r ead, knockdowns, i st, C: / User s/ ANSYS/ Deskt op/ Test/ si m233- mapdl / si m233- mapd

SOLVE

CMSEL, s, support _ext ernal _nodel _
EKILL, al |

ALLSEL

SOLVE

!load states.ist file
Irenove potential errors
Il oad knockdowns.ist file

I'sol ve nodel

Isel ect support named sel ecti
'kill current selection
Iselect all elenments

!'sol ve the updated nodel

Be sure to input correct file path to the files st at es. i st and knockdowns. i st saved within the
files for transfer to ANSYS mechanical folder. (Change the file path in the example commands above,
C. / User s/ ANSYS/ Deskt op/ Test / si n233- mapdl / si n233- mapd, to the correct file path.)
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Figure 21: ANSYS Workbench/Mechanical setup step 15

Commands
1 1 Commands inserted into this file will be executed just prior to the ANSYS SOLVE command.
2 ! These commands may supersede command settings set by Workbench.
3
4 ! Rctive UNIT system in Workbench when this object was created: Metric (m, kg, N, s, V, R)
) 1 NOTE: Any data that requires units (such as mass) is assumed to be in the consistent solver unit system.
€ ! See Solving Units in the help system for more information.
a . .
. 15 Make sure to input correct file address
S |INISTATE,read,states, ist, C:/Users/ANSYS/Desktop/Test/sim233-mapdl/sim233-mapdl A/ !load states.ist file
10 |[INISTATE, list, 1 / !remove potential errors
11 |INISTATE, read, knockdowns,ist,C:/Users/ANSYS/Desktop/Test/sim233-mapdl/sim233-mapdl !load knockdownss file
12
13 |sOLVE !solve model
14 |CMSEL, s, support_external model !select support named selection
15 |EKILL,all 'kill current selection
1€ |ALLSEL !select all elements
17 |SOLVE !solve the updated model|

Click the button highligted in Figure 22: ANSYS Workbench/Mechanical setup steps 16-17 (p. 23) to
show nodes on the cantilever geometry (step 16). Then, click the node located at the correct location
to extract distortion data (step 17). Make sure that the node is correctly chosen by checking the exact
location coordination information shown at the bottom status bar, Location = (0., 5.e-003, 1.25e-002)
m, as shown in Figure 22: ANSYS Workbench/Mechanical setup steps 16-17 (p. 23).

Figure 22: ANSYS Workbench/Mechanical setup steps 16-17
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Figure 23: Workbench/Mechanical setup steps 18-22 (p. 24) illustrates the next steps. Right click Solution,
and select Insert > Deformation > Directional (step 18-19). In the Details of Directional Deformation
window, change Orientation to Z Axis (step 20). Then right click Directional Deformation (step 21) and
choose Solve (step 22).
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Running the Simulations

Figure 23: Workbench/Mechanical setup steps 18-22
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As ANSYS Mechanical is solving the support-only cutoff, you can monitor the process via the progress
bar at the bottom (step 23 in Figure 24: ANSYS Workbench/Mechanical setup steps 23-24 (p. 24)). During
the solving process, you may notice some pop-up warning messages (like 24 in Figure 24: ANSYS
Workbench/Mechanical setup steps 23-24 (p. 24)), which are normal.

Figure 24: ANSYS Workbench/Mechanical setup steps 23-24
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Once the Solve process is completed, the distortion value of the selected node can be obtained in step

25 shown in Figure 25: ANSYS Workbench/Mechanical setup step 25 (p. 25). Note that this value only
represents the z-axis distortion induced by the support cutoff process. To obtain the total z-axis distortion,
you need to add the z-axis on-plate distortion value for measurement B from the Additive Print output
Figure 9: Measurement location B (p. 12). The sum of both the Additive Print on-plate distortion and

the ANSYS workbench support cutoff distortion is the value that you will use in the ANSYS Additive
Calibration spreadsheet to calculate the Strain Scaling Factor (SSF) and the Anisotropic Strain Coefficients

(ASCs), as shown in Figure 10: Workflow diagram for obtaining distortion simulation values, measurements
A and B (p. 16).
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Figure 25: ANSYS Workbench/Mechanical setup step 25
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Using the Spreadsheet to Calculate SSF and ASCs

An easy-to-use, customized spreadsheet (.xIsx file) is available to calculate the Strain Scaling Factor (SSF)
and the Anisotropic Strain Coefficients (ASCs). (The spreadsheet is available for download here.) Tabs

at the bottom of the spreadsheet (Calibration for AS, Calibration for SP, and Calibration for TS)
represent the three different simulation types.

O N W B W -

B

ANSYS Additive Calibration Record

=

92020 ANSYS, Ine.

gt Reserves.
Unaatharized wee, dishbution o dupliction s probibied

Material:

Machine:

Date of Build:

Date of Measurements:
Performed by:

Notes:

Machine Parameters
Layer Thickness ( (um)):
Starting Layer Angle (°):
Layer Rotation Angle (°):

Hatch Spacing (um):
Slicing Stripe Width (mm):
Laser Power (W):

Scan speed (mm/sec):

Base Plate Temperature (K):

Use and copy these
sheets as needed for
calibration tasks

/

Cover Page Results Summary I Calibration for AS I Calibration for SP I Calibration for TS I @®

Y

y

The sheets are designed so that you enter your own data in the colored-filled cells and the corresponding
values for SSF and ASCs will automatically be calculated based on formulas locked into the spreadsheet.
Sample values are included in the colored cells just as an example, so the first thing to do is clear the
sample data.
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Us

ing the Spreadsheet to Calculate SSF and ASCs

1.

SSF and ASCs Calibration for Scan Pattern Simulations

Geometry Distortion (mm)
E ﬁter ?QU r Measurements i
data here Il direction

1 direction

—

—

Extract distortion value
maodels scanned in || and L directions

(0.0)

at the location of interest from

(90,0)

Simulatio

Simulation settings

Mew sattings

Errori

number

55F

AsSC|

AsSCL

55F

ascl

ASC L

1 direction

Loo

150

0.30

|| direction
L direction

Linear Elastic

Simulatio Simulation

Simulation settings

New settings

Distortion (mmj)

iteration number

55F

asc||

ASC L

a5F

Ascll

ASCL

Errori

|| direction
Ldirection

1.00

1.50

0.50

|| directicn
1 direction

|| direction
Ldirection

|l direction

1 direction

J2 Plasticity

|| direction
L direction

|l direction
1 direction

|| direction
L direction

Run first calibration set to determine an initial set of factors (for each simulation type and stress

mode combination)

For a chosen combination of simulation type and stress mode, run simulations of the calibration

part in Additive Print. Use the spreadsheet to calculate factors.

a. @ Run a simulation of the calibration part using default SSF and ASCs.

28
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S5F and ASCs Calibration for Scan Pattern Simulations

Geometry Distortion (mm)
Measurements i 2 .l" |I "" |
|
|l direction 1.342 ""“"“" 8 :E, o) """""l - -[én ol
) Extract distortion value at the location of interest from
L direction 0.892 models built with scan patterns Land 2 (||and L )
Simulation | Simulation simulation settings New settings
) ) Distartion (mm) Erfaris
o Iteration number 45F AsC | Asci | ssF | AsC) | asci
o || directi
rection 3.456 157.5%
= 1st 1.00 1.50 0.50 0.43 1.0 0.50
l: L direction 1.785 100.2%
m || direction
E 2nd Ldirection
= || direct
Irection
3rd
1 direction

X . . . . . .
b. Calculate new SSF and ASCs using simulation distortion data compared to measured distor-
tion data from the calibration part. (This is done automatically with formulas built into the

spreadsheet.)

SSF and ASCs Calibration for Scan Pattern Simulations

Geometry Distortion {mm)
Measurements o

|| direction 1.347

1 direction 0.852

e

0,0)

Extract distortion value at the location of interest from
models built with scan patterns 1 and 2 (land L)

I

Simulation | Simulation Simulation settings Mew settings
) ) Distortion {mm) Errori
o iteration number S5F asc| | asc1 | ssF | asc| | asci
L »
B 15t | direction e 1.00 150 | 050 | 043 | 120 | om0 pR3E
™ 1 direction 1.786 100. 2%
E
o 2nd | direction 1678 0.43 120 | 0s0 | 02s | 120 | om0 p22E
g n 1 direction 111 ' ’ ' : - ' 25.7%
3rd | direction 0.34 120 | 0.80
1 direction
CY e o
C. Run simulations using calculated SSF and ASCs, and then iterate until the new SSF
and ASCs converge to an acceptable level of error between measured and simulated distortion.
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Using the Spreadsheet to Calculate SSF and ASCs

2.

S55F and ASCs Calibration for Scan Pattern Simulations

Geometry Distortion {mm)
Measurements i ; l l l l "
. e Qg
Il direction 1342 ([l [ (0,0) u l {90,0)
Ldwect Extract distortion value at the location of interest from
frection 0.532 models built with scan patterns 1 and 2 ( || and 1 ]
Simulation Simulation ) . Simulation 5E‘ttiﬁ35 MNew Seﬂing,s
Distortion {mm) Error¥
o fteration number S5F ASC| | AsCL | SsF ASCl | AsCL
=
directi 3.456 157.5%
= 15t jdirection 1.00 150 | o050 | 043 | 120 | o0s0
“I: L direction 1.786 100.2%
o direct 1. 25.0%
b 2nd | direction L 0.43 120 | 080 | 03a | 120 | om0
£ 1 direction 111 25.7%
=
|| direction 1.36 1.3%
Ird 0.34 1.20 0.80 0.42 119 0.81
Ldirection 0.90 0.7%

Run fine-tuning calibration step with a different scan pattern

a. @ Run a simulation of the calibration part using a rotating stripe scan pattern and the calibrated SSF

and ASCs.
SSF and ASCs Additional Calibration for Scan Pattern Simulations
Geometry Distortion (mm)
Measurements : e """'
Rotating stripe scan pattern o "l"ul
[or user-customized) : Extract distortion value at the location of interest from
models built with third scan pattern (rotating stripe)
Simulation | Simulation Simulation settings MNew settings

-:u_, ) ) direction | Distortion (mm) g £ Errori
@ iteration number S5F ASC|| | ASCL | S5F ASC| | ASCL
E 15t rotating 0.758 0.34 1.20 0.80 0.21 1.20 0.80 | 63.4%
1]
- 2nd retating 0.21 1.20 0.80

b. @ Run simulations using the newly-calculated SSF and then iterate until the new SSF converges

to an acceptable level of error between measured and simulated distortion.
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SSF and ASCs Additional Calibration for Scan Pattern Simulations

Geometry
Measurements

Distortion (mm)

Rotating stripe scan pattern
{or user-customized)

e

L Extract distortion value at the location of interest from
models built with third scan pattern (rotating stripe)

Simulation | Simulation Simulation settings New settings
E ATTIHER direction | Distortion (mm) - - g L Errori
0 iteration number S5F ASC | AsCL | 55F asc| | ascL
- 1st rotating 0.758 0.34 120 | 080 | 021 | 120 | o080 | 63.4%
:
= 2nd rotating 0.47 0.21 1.20 0.80 0.21 1.20 0.80 0.2%

c. Record the final SSF and ASCs in a table such as the one shown in Table 1: Complete matrix of SSF and

ASCs (p. 3).

Other Considerations

The distortion values seen in the spreadsheets are for demonstration purposes only. Distortion values
will vary based on material, machine, and build parameters.

You will need to copy calibration sheets for other simulations.

If you use both locations A and B (assuming that both values are useful and measurable), use the average
value of SSF and ASCs obtained from the spreadsheet after the simulations. Therefore:

SSFcantiIever_beam= (SSFA+SSFB)/2
ASCcantilever_beam”: (ASCA||+SSFB||)

/2

ASCcantiIever_beamJ_=(ASCAJ_+SSFBJ_) /2
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Saving Your Final Results as Custom Materials

The calibration process is complete when you have obtained values for SSF and ASCs that are within
an acceptable level of error between measured and simulated distortion. Because the goals of every
company and the design of every manufactured part are unique, it is up to you to decide what is an
acceptable level of error. Record the final values in the Results Summary sheet in the spreadsheet. (The
Results Summary sheet is the same as Table 1 shown in this guide.) Then use those new values of SSF
and ASCs for all your simulations in Additive Print for that machine and material.

Within Additive Print, we recommend you save the final SSF and ASCs by creating customized materials
for each material/simulation type/stress mode combination.

In the Materials library, select your material and then click Customize. This brings up an edit panel where
you can change the SSF and ASC values to the final calibrated values. Then be sure to select the appro-
priate custom material when performing future simulations.
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Saving Your Final Results as Custom Materials

m Customize Material
Pﬁs Details
O Name IN718 - SP - LE
Build Files
Description Use for Scan Pattern simulations with linear elastic stress mode.
1 Includes new values of SSF and ASCs after calibration process.|
Materials “
Details
Powder Absorptivity 0.76
Solid Absorptivity 0.47
Thermal Expansion Coefficient (K1) 0.0000128
Elastic Modulus (GFa) 211
Poisson Ratio 0.3
Material Yield Strength (MPa) 1040
Hardening Factor 0.0048
Support Yield Sirength Ratio 0.4375
Strain Scaling Factor
Anisotropic Strain Coefficients {|])
Anisctropic Strain Coefficients (1)
Anisotropic Strain Coefficients (Z) 1
‘ E ’Cancel
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Appendix A. Equations for Calculating SSF and ASCs

The equations used in the ANSYS-provided spreadsheet (p. 27) for calculating the Strain Scaling Factor
(SSF) and Anisotropic Strain Coefficients (ASCs) are shown here for reference.

The following SSF and ASC equation topics are available:

Nomenclature (p. 35)
Linear Elastic Stress Mode Calculations (p. 35)

Plasticity Stress Mode Calculations (p. 36)
For an overview of the calculation process, see Process Flow for the SSF and ASCs Calculations (p. 39).

Nomenclature

The equations in this appendix use the following standard nomenclature:

Table 2: Variables

Variable Meaning
Se Experimental distortion
Ss Simulation distortion
r Ratio

Table 3: Subscripts

Subscript Meaning
| | Parallel to the scan direction
L Perpendicular to the scan direction
n-1 Setting before the most recent
iteration
n Setting of the most recent iteration
n+1 Setting for the next iteration
01,2,.. iteration 1, iteration 2, iteration 3,
m Modified version

Linear Elastic Stress Mode Calculations

Assumed Strain SSF
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Equations for Calculating SSF and ASCs

_de

SSFneW—g

'SSFold

Scan Pattern / Thermal Strain SSF

be|+be,

SSF o=y 55,

'SSFold

Scan Pattern / Thermal Strain ASCs

2
6e||
ASC, =2-ASC),

Plasticity Stress Mode Calculations

Follow these steps to perform the plasticity stress mode calculations:

Step 1:Set the First Iteration of Simulations
Set the first iteration of simulations using these defaults:
* Assumed Strain mode: SSF,=1

» Scan Pattern / Thermal Strain mode: SSF(=1, ASC|;=1.5,and ASC ,=0.5

For Assumed Strain mode, extract target distortion value Js,.

For Scan Pattern / Thermal Strain mode, extract target distortion value 650“ from one simulation, and

s, from a second simulation.

Step 2: Calculate the New SSF and ASCs

Calculate the new SSF and ASCs after the first iteration:

Assumed Strain

SSF,=(8e/ 8s4)SSF,

Scan Pattern / Thermal Strain

Calculate the average value of distortion in the parallel and perpendicular directions after the
first distortion:

5| |+5l
avg(6)=—L1

Calculate SSF and ASC in the second iteration by:
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avg(de)

SSF1=SSFogygis)

Se|+6s,
ASC|p=(2-45¢) |0J(—69l+65||_1)+‘45€| o

Step 3: Determine Whether the New SSFIs <1 or > 1

If the suggested new SSF; is less than 1, set SSF,,, = 0.002 and run the simulation to extract Js;.

If the suggested new SSF, is grater than or equal to 1, set SSF,,, = SSF; and run the simulation to extract
0S1-

Step 4: Perform Linear Interpolation Between Iterations 1 and 2

Perform linear interpolation between the iteration 1 (default value) and iteration 2 to extract SSF,, ASC,,
and the values for the subsequent iterations.

For SSF,,,, = 0.002 (SSF; < 1)

Se-65,) (SSF1-SSF
1. ssp,=L98 ?:5)5(1-55;) ), 555,

2. Determine whether avg(ds,)<avg(de)<avg(ds,).

If Yes:

(6e-6s,)(SSF,-SSF,)
SSF 1= (65,050 +SSF,, wheren 2 2

If No:

Se-65,) (SSFu-SSF
ssr,, =% i%)s(- 53 o), 55, wheren > 2
n

For SSF,,,, = SSF, (SSF1 > 1)

(6e-6s, 1) (SSF,~SSF, 1)

SSF 1= +SSF,_ 1, wheren 2 1

(65,—05,1) n-1’
For Both Cases
5S|| 56”
r=5—l r‘e=5—el
ASC _ (re—rn—l)(ASC”n_ASC“n—l) ASC
|Im+1= (rn=rmn1) TA |

AS'CHHFZ—I‘LS'C]|n+1
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Equations for Calculating SSF and ASCs

Step 5: Calculate the Relative Error

|5$||n—5e|||

s, ,—oel
Calculate the relative error T”' where n>1 and M

5oL ,where n>1.

Determine whether the error exceeds your tolerance.

If Yes:

End the calibration program.

If No:

Go back to the iteration.
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Process Flow for the SSF and ASCs Calculations

go back to iterations

Extract 655 when SSFp=1

v

Is predicted SSF, <17
yes |

Set SSF;,, = 0.002 and
calculate avg(és1)

no

=

Set SSF,,, = SSF,
Do linear interpolation

until error < tolerance
|

v
Is avg(ds,) > avg(de)?

ves o
Use iteration 2 and 3
to do the linear

interpolation
I

no

Use iteration 1 and 3
to do the linear

interpolation
|

no

Use iteration 1 and n
to do the linear

interpolation
|

4
Is avg(dsn_1y) > avg(de)?
yes
Use iteration 2 and n
to do the linear
interpolation
[
4
1o
Is error < tolerance?
yes |
END -

l[teration 1

Iteration 2

I[teration 3

lteration n
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